
Metallic Silver Ink Guide

This document describes the printing method using the metallic silver ink in combination of Roland Versa-
Works and BN-20.
For other information, refer to the BN-20 First Step Guide and MASTER GUIDE.

Before reading this document, you need to read the im-
portant notes to handle the metallic silver ink that are 
contained in the BN-20 MASTER GUIDE.



Thank you very much for purchasing this product.

	To ensure correct and safe usage with a full understanding of this product's performance, please be sure to read through 
this manual completely and store it in a safe location.

	Unauthorized copying or transferal, in whole or in part, of this manual is prohibited.
	The contents of this operation manual and the specifications of this product are subject to change without notice.
	The operation manual and the product have been prepared and tested as much as possible. If you find any misprint 

or error, please inform us.
	Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur through use of 

this product, regardless of any failure to perform on the part of this product.
	Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur with respect to 

any article made using this product.
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What This Document Assumes and Related Manuals

What This Document Assumes
Before performing any operations described in this guide, make sure that all the following preparations have 
been complete.
 Assembling and installing the BN-20 (it is called, "This machine" at the following) unit
 Installing VersaWorks on your computer, and connecting the computer to this machine via a network

Related Manuals
Read the following documentation for information about setting up this machine and VersaWorks.

 First Step Guide
Preparation to use this machine, the installation location conditions, and "Printing and Cutting for the First 
Time" are explained. Be sure to read this guide.

 MASTER GUIDE
The detailed operation procedure, important notes specific to the metallic silver ink, and maintenance method 
are described. Be sure to read this guide after reading  .

 Roland VersaWorks Quick Start Guide
Chapter 1 of this manual, “Setting for VersaWorks,” provides you with instructions necessary to perform print-
ing with VersaWorks, including how to install the software. Be sure to read this chapter following the above 
MASTER GUIDE.
You are also recommended to read Chapter 2, “Getting Started,” to become familiar with how to use this 
program.

VersaWorks Online
This document describes the important notes to use the metallic silver ink as well as the basic printing method 
using these inks. You can get the latest information about Roland VersaWorks and the information on printing 
methods requiring more complex settings by viewing VersaWorks Online. If you want to learn more about 
the features of Roland VersaWorks, or if you want to use metallic silver ink more effectively, be sure to visit 
VersaWorks Online.
URL : http://dg4.roland.co.jp/en/RVW2forWeb/index.html

VersaWorks Online can be displayed by clicking [help] - [VersaWorks Online] from the main menu.



Chapter 1 
Getting Ready

1-1 Preparing VersaWorks..............................................................4

Starting VersaWorks.....................................................................4

Creating a Folder for Saving PS Files..........................................4

1-2 Creating Printing Data..............................................................5

Basic Approach for Creating Printing Data...................................5

Creating Data for Printing.............................................................5

Blend Print and Layered Print....................................................11

3



4 Chapter 1  Getting Ready Chapter 1  Getting Ready

1-1 Preparing VersaWorks

Starting VersaWorks
On the computer you are using, start VersaWorks. For information on how to start the program, see the Roland 
VersaWorks Quick Start Guide. After starting the program, go to the upper left of the main screen and check to 
make sure that "Model (or Nickname) of Your Printer" is displayed, and that "Status" is set to "Ready to Print."

Creating a Folder for Saving PS Files
Before you actually print an image you draw using application software such as Adobe Illustrator, it is necessary 
to save the image as a PS file(s). And then, you can print the image by loading the PS file(s) on VersaWorks.
Because of this, you should create a folder for saving PS files in advance. It is recommended to locate the folder 
in the root directory on your computer's local disk.

Procedure

 Open [Computer] ( or [My Computer]), and then open [Local Disk (C:)].

 On the [Organize] menu, click [New Folder]. 
(Or on the [File] menu, click [New], and then 
click [Folder].)

 Enter the name for the folder, and then press 
the Enter key.
Here you name the folder "MT_print", for example.
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1-2 Creating Printing Data

Basic Approach for Creating Printing Data
When you're printing using metallic silver ink, you create the printing data using a spot color.
You can create the printing data according to the two methods below.
 Specify the spot color so as to use only the metallic silver ink.

Specify the spot color named "RDG_MetallicSilver" to the areas you want to print using the metallic silver 
ink.
 Specify the spot color from the exclusive metallic color special colors library.

From the exclusive metallic color special colors library, select the special metallic color (spot color) to be used 
which is the combination color of CMYK ink and metallic silver ink.

Creating Data for Printing
Create the data for printing using the metallic silver ink.
The program used to create the printing data is Adobe Illustrator CS3, in this section. For detailed information 
on drawing methods and how to work with palettes, refer to the documentation or online help for Adobe 
Illustrator CS3. If you are using another version of Adobe Illustrator, operations may be somewhat different 
from those explained here.

1. Open the exclusive swatch library.

 At the swatch palette menu, select [Open Swatch Library], then [Other Libraries].
The "Select Library" window appears.
The swatch palette is displayed by going to the menu, selecting [Window], and then selecting 
[Swatch].
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  Open folders in the order of [Computer] (or [My Computer]) → [Local Disk (C:)] → 
[Program Files] → [Roland VersaWorks] → [Swatch] → [Illustrator], then select "Roland 
VersaWorks.ai"
Depending on the settings of your computer, the extension ".ai" might not be shown.

 Click [Open].
The swatch library containing "RDG_MetallicSilver" is displayed.

  Open the same folders as in step, and then select "Roland Metallic Color System 
Library.ai."
Depending on the settings of your computer, the extension ".ai" might not be shown.

 Click [Open].
The swatch library is displayed which is containing the "metallic color" created by mixing the metallic 
silver ink and CMYK ink.

By saving the ".ai" file selected in steps  and  into the folder below, you can register each swatch 
library to the Adobe Illustrator's library.
C:\Program Files\Adobe\Adobe Illustrator CS3\Preset\Swatch
("C" is the name of your computer's local disk.)
Once the registration is performed, you can open the library directly from the swatch palette menu, 
eliminating the need to search the file every time you start Adobe Illustrator.
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1-2 Creating Printing Data
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2. Create the illustration, and specify the spot color that matches the color you want to print.

 Create the illustration.
Be sure to draw the illustration in the CMYK mode.

 Specify each spot color that matches the color you want to print.

Desired ink or color Spot color name

Metallic silver ink RDG_MetallicSilver
Metallic color RVW-MT-Silver, RVW-MT-Bronze, RVW-MT-TitanBlack, 

etc.

Using the metallic silver ink, you can perform the blend print and the layered print by combining the 
ink with the CMYK ink.

 P. 11, “Blend Print and Layered Print”

Areas where you want to use metallic color
From the metallic color special colors library (Roland 
Metallic Color System Library), specify the color such 
as "RVW-MT-Bronze"

Specify " RDG_MetallicSilver " for 
the areas where you want to use 
metallic silver ink.
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3. Create the PS (PostScript) file.

  Select [Print] from the [File] menu.

 Select [Roland VW].
When a nickname is set, or when more than one 
printer is connected, select “Roland VW_(the nick-
name of the printer used for output).”

 Click [Setup].

 Click [Continue].
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  Turn on the [Print to file] option.

 Click [Preferences].

 Click [Advanced] in the [Layout] tab.
For Windows 2000: In the "Print" dialog box 
(the window at the very top of this page), go 
to the "Layout" tab and click [Advanced].

 Click the down arrow to the right of the
[Paper Size] box, and then click [PostScript 
Custom Page Size] from the list that ap-
pears.

 For "Custom Page Size Dimensions," 
enter the values in the "Width" and "Height" 
fields.
Enter values for the same size as the illustration you 
created in step 2..
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 Click [OK] three times to close the "PostScript Custom Page Size Definition," "Roland 
VersaWorks Advanced Options," and "Printing Preferences" dialog boxes.
The "Print" dialog box returns.

  Click [Print].

 Click [Print].

  Specify the destination and file name 
for saving,
Example: " C:\MT_print " for the folder to save to, and 
" mt.ps " as the file name

 Click [Save].
The CMYK layer of the image is saved as a PS file.

 Open the folder you saved to and make sure the file has been created.

Select the folder you created in 
"Creating a Folder for Saving PS 
Files" on page 4.

Assign the name you want. It may 
be a good idea to assign a name 
that indicates that the file uses 
white and metallic silver ink.
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Blend Print and Layered Print
The blend print and the layer print are printing methods in which the metallic silver ink is combined with 
the CMYK ink. Both methods enable metallic printing which cannot be available only with the CMYK ink. The 
blend print and the layer print are different from each other in terms of how to print.  They are different also 
in the metallic impression of CMYK. You can select the blend print or layer print in [Mode] of the print setting. 
You can select either print mode according to your preference.

 P. 16, “Blend Print (Metallic Silver + CMYK),” p. 18, “Layered Print (Metallic Silver  CMYK),” p. 20, “Layered Print 
(CMYK  Metallic Silver)”

In performing the blend print or the layered print, you can specify the colors from the metallic color 
special colors library. However, if you specify the metallic colors with the same names 
for the blend print and the layered print, the tones of the colors are different between 
them. We recommend that you check the tones of the colors by performing the test printing or 
printing out the Metallic Color Chart.
Seeing the metallic color chart for the layered print, you may feel a slight inconsistency between the 
names and the tones of the colors. This is because the colors listed in the Metallic Color Chart are 
named based on those for the blend print.

 P. 24, “Printing a Metallic Color Chart”
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2-1 Print Job Setting

Printing Only with Metallic Silver Ink
This section describes how to perform printing only with the metallic silver ink. To use the metallic silver ink 
in printing, you need to use the printing data where the use of the metallic silver ink is designated. If the 
printing data have the portion designating the use of other colors, with the settings described in this section, 
you can print with the metallic silver ink only the area of the image which has been designated to print with 
the metallic silver ink.

 P. 5, “1-2 Creating Printing Data”

Procedure

 Make sure that you have finished making the preparations for VersaWorks, getting the 
printer ready, and creating the printing data ( page 3, "Chapter 1 -- Getting Ready").

 Double-click .
Queue A Properties" window appears.

  Click .

 Select [Media Type].
Make the selection that matches the media to be 
used.

 For [Mode], select [MetallicSilver (v)].
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2-1 Print Job Setting

  Click .

 Turn on the [Convert Spot Color] op-
tion.

  Click .

 In [Operation Mode], select the operation 
of the printer.

 Click [OK] to close the "Queue A Proper-
ties" window.

This is the end of the print job setting. To start printing, go on to page 23 “Starting the Print Operation.”

* Only the settings necessary for the use of the metallic silver ink are described in this section. For other set-
tings, refer to the online help provided for VersaWorks.

* If you select [CMYK (v)] for [Mode] in the procedure, [only the area of the image where CMYK is specified 
in the printing data is to be printed.
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2-1 Print Job Setting

Chapter 2  Printing

Blend Print (Metallic Silver + CMYK)
This section describes how to perform the blend print with the metallic silver ink and CMYK ink.

 P. 11, “Blend Print and Layered Print”
To perform the blend print, you need to use the printing data where the use of the metallic silver ink and the 
CMYK ink is designated.

 P. 5, “1-2 Creating Printing Data”

(Image of printing method)

Procedure

 Make sure that you have finished making the preparations for VersaWorks, getting the 
printer ready, and creating the printing data ( page 3, "Chapter 1 -- Getting Ready").

 Double-click .
Queue A Properties" window appears.

The metallic silver ink and the CMYK ink are blended to be a single layer 
for printing.

Media

Metallic Silver and CMYK
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2-1 Print Job Setting

  Click .

 Select [Media Type].
Make the selection that matches the media to be 
used.

 For [Mode], select [CMYKMt (v)].

  Click .

 Turn on the [Convert Spot Color] op-
tion.

  Click .

 In [Operation Mode], select the opera-
tion of the printer.

 Click [OK] to close the "Queue A Proper-
ties" window.

This is the end of the print job setting. To start printing, go on to page 23 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, 
refer to the online help provided for VersaWorks.
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2-1 Print Job Setting

Chapter 2  Printing

Layered Print (Metallic Silver  CMYK)
This section describes how to perform the layered print with the metallic silver ink and CMYK ink using the 
metallic silver ink as background.

 P. 11, “Blend Print and Layered Print”
To perform the layered print, you need to use the printing data where the use of the metallic silver ink and 
the CMYK ink is designated.

 P. 5, “1-2 Creating Printing Data”

(Image of printing method)

Procedure

 Make sure that you have finished making the preparations for VersaWorks, getting the 
printer ready, and creating the printing data ( page 3, "Chapter 1 -- Getting Ready").

 Double-click .
Queue A Properties" window appears.

The metallic silver ink and the CMYK ink are separated into the different layers 
and printed in that order. (Metallic silver ink  CMYK ink)

Media

Metallic Silver

CMYK
The printed image is to be 
seen from this side (the printed 
surface of the finished results).
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2-1 Print Job Setting

  Click .

 Select [Media Type].
Make the selection that matches the media to be 
used.

 For [Mode], select [Mt -> CMYK(v)].

  Click .

 Turn on the [Convert Spot Color] op-
tion.

  Click .

 In [Operation Mode], select the operation 
of the printer.

 Click [OK] to close the "Queue A Proper-
ties" window.

This is the end of the print job setting. To start printing, go on to page 23 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, 
refer to the online help provided for VersaWorks.
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2-1 Print Job Setting

Chapter 2  Printing

Layered Print (CMYK Metallic Silver)
This section describes how to perform the layered print with the metallic silver ink and CMYK ink using the 
CMYK ink as background.

 P. 11, “Blend Print and Layered Print”
To perform the layered print, you need to use the printing data where the use of the metallic silver ink and 
the CMYK ink is designated.

 P. 5, “1-2 Creating Printing Data”

(Image of printing method)

Procedure

 Make sure that you have finished making the preparations for VersaWorks, getting the 
printer ready, and creating the printing data ( page 3, "Chapter 1 -- Getting Ready").

 Double-click .
Queue A Properties" window appears.

Metallic Silver

CMYK

The metallic silver ink and the CMYK ink are separated into the different layers 
and printed in that order. (CMYK ink  Metallic silver ink) 

Media

The printed image is to 
be seen from this side 
(the opposite side of the 
printed surface of the 
finished results).
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2-1 Print Job Setting

  Click .

 Select a media type having a name of 
"PET Clear Film" in [Media Type].

 For [Mode], select [CMYK (v) -> Mt].

  Click .

 Turn on the [Convert Spot Color] op-
tion.

  Click .

 In [Operation Mode], select the opera-
tion of the printer.

When You Want to Display the Side Opposite the Printed Surface by Using Clear Film.

 Click .

 Turn on the [Mirror] option.
When the printing data with mirror image is 
prepared beforehand, you do not need to turn 
on this option.
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2-1 Print Job Setting

Chapter 2  Printing

 Click [OK] to close the "Queue A Proper-
ties" window.

This is the end of the print job setting. To start printing, go on to page 23 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, 
refer to the online help provided for VersaWorks.



23Chapter 2  Printing Chapter 2  Printing

2-2 Starting the Print Operation

Starting the Print Operation
Following the print job setting, you can start the print operation.

Procedure

 Make settings for the print job.
 P. 14, “2-1 Print Job Setting”

 Load a media.
 "BN-20 First Step Guide", "BN-20 MASTER GUIDE"

 Go to “Job List,” click the “Queue A” tab, 
and drag the printing data to the queue A job 
list (If the print job setting has been made in 
[Queue B], drag and drop the printing data 
on the job list of [Queue B].).

The contents of the data are displayed in the preview window, and the layout on the media is displayed 
in the layout window.

Areas using “RDG_MetallicSilver” 
or special metallic color (RVW-
MTBronze, etc.) are displayed with 
shading in transparent gray.
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2-2 Starting the Print Operation

Chapter 2  Printing

 Select the print job in the job list, and then 
click .
Printing will be started.

Printing a Metallic Color Chart
The Metallic Color Chart is the printing sample of the special metallic color. By printing the Metallic Color Chart, 
you can confirm the “complete metallic color chart” representing the special metallic color itself that can be 
printed with “Your Printer” and “Your Media” (slight pattern differences is possible to occur depending on the 
conditions of the printer and media.) By selecting colors from this color chart and creating illustrations with 
these colors, you can accurately reproduce the desired colors.

Procedure

u Make sure that you have finished making the preparations for VersaWorks, and getting 
the printer ready ( page 3, "Chapter 1 -- Getting Ready").

 Double-click .
Queue A Properties" window appears.

After printing, allow the ink to dry sufficiently. 
We strongly recommend performing lamina-
tion.

To continue printing similar data, repeat steps and . Also, if you want to modify detailed set-
tings for each job, it will be convenient to perform modifications in the “Job Setting” window (which 
you can display by double-clicking the print job in the job list).
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2-2 Starting the Print Operation

  Click , configure the settings in [Qual-
ity Settings] and [Color Management].
 P. 14, “2-1 Print Job Setting”

 Click [OK].

x  Click [Media] and then [Metallic Color 
Chart].

 Click [OK].
The print job of the Metallic Color Chart is added to 
the job list.

When printing a Metallic Color Chart, the [Quality] settings from the [Queue Properties] window are 
always applied. Since you cannot change the quality settings for the job using the [Job Settings] 
window after it has been added, be sure to configure the settings in the [Queue Properties] window 
before performing the following operations.
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2-2 Starting the Print Operation

 Click  .
Printing will be started.
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3-1 Performing Texture Printing

What is Texture Printing?
Texture printing is a printing method to produce texture patterns. This uses the texture patterns of the ex-
clusive library to create and output the printing data. This document describes the texture printing using 
metallic silver ink.

* Create the printing data using the Adobe Illustrator version of CS or later if using Adobe Illustrator. If you 
use the earlier version before Adobe Illustrator 10 to create the printing data, the texture patterns may 
result in poor condition. 

Create The Texture Printing Data
To create the data for the texture printing, please follow the instructions below.
The program used to create the printing data is Adobe Illustrator CS4. For detailed information on drawing 
methods and how to work with palettes, refer to the documentation or online help for Adobe Illustrator 
CS4. If you're using another version of Adobe Illustrator, operations may be somewhat different from those 
explained here.

1. Open the exclusive library.

 At the swatch palette menu, select [Open Swatch Library], then [Other Libraries].
The "Select Library" window appears.
* The swatch palette is displayed by going to the menu and selecting [Window], then [Swatch].
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3-1 Performing Texture Printing

  Open folder in the order of [Computer] (or [My Computer]) → [Local Disk (C:)] → 
[Program Files] → [Roland VersaWorks] → [Swatch] → [Illustrator], and then select 
"Roland Metallic Texture System Library.ai."
Depending on the settings of your computer, the extension ".ai" might not be shown.

 Click [Open].
The exclusive swatch libraries “Roland Metallic Texture System Library.ai“ is displayed.

By saving the ".ai" file selected in step into the folder below, you can register the exclusive library 
to the Adobe Illustrator's library.
C:\Program Files\Adobe\Adobe Illustrator CS4\Preset\Swatch
("C" is the name of your computer's local disk.)
Once the registration is performed, you can open the library directly from the swatch palette menu, 
eliminating the need to search the file every time you start Adobe Illustrator.
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3-1 Performing Texture Printing

Chapter 3  Performing Texture Printing

2. Create Illustrations and Specify Texture Patterns You Wish to Use

 Create the illustration.
Be sure to draw the illustration in the CMYK mode.

 Assign the desired texture patterns to the areas for the texture printing.
The areas where the texture patterns are assigned shall be printed with metallic silver ink. When the 
metallic silver ink is to be used for the printings other than the texture printing, other special spot colors 
shall be used. For the detailed usage, please refer to “Chapter 1 Getting Ready”.

* The name of the texture pattern is displayed on the data of Illustrator. The texture of the displayed image 
appears rougher than that of the actual print.

3. Create the PS (PostScript) file.

Create a PS file as referring to the steps of the procedure 3 in "Creating Data for Print-
ing" in pages 8 to 10.

The area to be printed with the texture pattern 
 From " Roland Metallic Texture System 
Library," specify the texture pattern such as 
"RTSL-MT-Standard-020."
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3-1 Performing Texture Printing

Performing Texture Printing

Procedure

 Prepare the printing data having been created in the previous process which is de-
scribed in “Create The Texture Printing Data” on page 28.

 Make the setting to output metallic silver ink with the VersaWorks, and execute the 
printing.
To use the metallic silver ink, you need to select "CMYKMt", etc. in the print mode of VersaWorks.
For the detailed method of setting, please refer to “Chapter 2 Printing”.

Printing a Texture Chart
The texture chart is the printing sample of the texture pattern. By printing the texture chart, you can confirm 
the “complete texture chart” representing the texture itself that can be printed with “Your Printer” and “Your 
Media” (slight pattern differences is possible to occur depending on the conditions of the printer and media.) 
By selecting a pattern from this texture chart and creating the printing data using that selected pattern, you 
can print your intended pattern almost perfectly.

Procedure

 Double-click  .
The [Queue A Properties] window appears.

  Click , configure the settings in [Qual-
ity Settings] and [Color Management].

 Click [OK].

Note: When printing a texture chart, the [Quality] set-
tings from the [Queue Properties] window are always 
applied. Since you cannot change the quality settings 
for the job using the [Job Settings] window after it 
has been added, be sure to configure the settings in 
the [Queue Properties] window before performing 
the following operations.
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3-1 Performing Texture Printing

w  Click [Chart] under [Print Roland Texture 
System Library] form the [Media] menu.

This message appears: The following job will be 
printed. Do you want to continue? Check that the 
media in the printer is large enough for the displayed 
page size.

 Click [OK].
The texture chart is added to the job list.

x Click  .
Rip'ing and printing the texture chart are per-
formed.

* In the texture chart, color is added to part of the 
background of the texture. This makes the design of 
the texture clear.
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